


Imporng Geo and Textures from Maya into Unreal Engine

Although it is possible to import .x files into UE, many rigs are not game-ready and will 
not import properly, or at all.  For example, cinemac rigs that have more than one root 
will not import.  The most solid method to import animated geo into UE is to use Alembic 
Cache (.abc file).

The Export Process (Maya):

- Ma- Make sure that materials are applied to objects.

- Select geo only for object, not a parent group.  The objects can be grouped but must be 
selected individually. The easiest way to do this is show Polygons only in the viewer and 
drag select the geometry in the scene that you want to export.

-UE will not import Alembic geometry that includes n-gons, so you may have to run a mesh 
cleanup to fix before export.

-Cache > Alembic Cache > Export 
Selecon to Alembic

- In Alembic Export Opons under 
Advanced Opons, make sure UV 
Write, Write Color Sets, and Write Face 
Sets are checked.  

*If *If you have a problem later bringing in 
textures to UE, you may need to 
rewrite .abc with Write UV Sets 
checked, but usually this is not 
necessary.*

-Name file and Export Selecon
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The Import Process (UE):

-Drag Alembic .abc file into the content browser.  (The default locaon for Alembic files is in 
Maya Project > Cache > Alembic)

Import Opons window:

-Import Type: Geometry Cache (Experimental)

-Uncheck Flaen Tracks (otherwise only one material will be applied everything)

*Ha*Hard Angle Threshold: lower value will create smoother normals*

-Check Create Materials

-Preset: Autodesk 3ds Max (for some reason this works with Alembic files from Maya.  
Using the maya se ng will import your geo with incorrect orientaon).

-Import

-Drag object from content browser into scene.
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Playing Animaon in UE Sequencer:

-Create Level Sequence
-Put playhead at start 
-Drag Geometry Cache object from world outliner into area le of meline in sequence.

-Click  +track > Geometry Cache

-Animaon should play back when sequencer is played.
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Creang Materials and Applying Textures (UE):

-If Alembic is successfully imported it will 
create separate elements for each material.  
They will all be set to WorldGridMaterial by 
default.  You will need to create material 
instances inside of UE and apply them to 
each of the elements.  

The Process:
--Drag all your texture files from your Maya 
project folder into the content browser.  
Creang a separate folder is best pracce.

-Rig-Right-click in Content browser area and select 
Material under Create Basic Asst.  Name this 
material MasterMAT.  Creang one master 
material makes it easier to set up mulple 
material instances later.
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Applying Textures (UE) cont.

-Save and close masterMAT blueprint.

-In content browser right-click masterMAT and select Create Material Instance. You 
will need to do this for each material that you have in your scene.  Name according 
to material set (example faceMAT, clothesMAT, etc).

-Inside each m-Inside each material instance, check the parameters you want to change 
(BaseColor, Normal, Spec..)  These are the parameters you set up in the master 
material.

-Double-click masterMAT and drag texture image files for first material into the 
blueprint. Connect texture node to base color, normal, spec, etc depending on what 
textures you have. (use RGB output pin)

-right click on  each Texture node and click Convert to Parameter.  Name parameter 
appropriately (BaseColor, Spec, etc). This will have to be done for each texture node.
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Applying Textures (UE) cont.

-In content brower, drag newly created material instances into the elements of your 
geometry cache. It may take trial and error to assign correctly because the elements are 
not named.  *Some geo might import FaceSet names from Maya, but usually not, and 
creang FaceSets in Maya pre-import may causes problems with rig animaon.*

-drag and drop the appropriate texture maps into the material instances to create your 
materials. Save each instance before closing.

7



Imporng Camera from Maya into Unreal Engine:
Export Camera from Maya:

-Bake camera animaon

-Unparent camera from any other objects in 
outliner

-Select camera only

-Export selecon as .-Export selecon as .x

-write down Camera Aperture (mm) – 
both values – from Camera Aributes Editor. 
 You will need these values to set up camera 
inside UE

Import Camera to UE:

-Create level sequence if you haven’t already

-C-Create (drag and drop) Cine Camera Actor 
into sequence.  Drop into area le of the meline.

-Right click on Cine Camera Actor
in sequencer then click Import

-Select .x camera file

-Uncheck “Match Name Only”

-Uncheck “Reduce Keys”

-Import-Import

8



Imporng Camera cont.
-In newly created Cine Camera Actor Details panel, change sensor width and height to 
match Camera aperture se ngs (mm) from Maya (In Maya the first number is Width).

-In Details panel for the Cine Camera Actor 
set Focus Method to Disable.  This could be 
a bug, but I have found that 4k renders from 
the Cinemacs Movie Render Queue and 
Sequencer Movie render were blurry unless 
I set Focus Method to Disable.  For most 
projects, depth of field should be applied in 
comp comp stage using depth pass.

35.999
24.000

*Copy values from Maya camera 
and past into Unreal - otherwise 
camera will not match*
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Exporng Render Passes from Unreal Engine:

These processes will generate the following passes for use in Nuke:

Beauty
Alpha
Base Color

Ambient Occlusion
LigLighng Only
World Normal

Post ToneMapColor
Depth
Shadow

Contact Shadow

Notes:

-I am using -I am using Unreal Engine 4.26.1

- Cinemac Movie Render Queue and Sequence Movie Render automacally render 
the playback range of the sequence.  For a single frame, the sequence must be at least 
two frames long (example playback range 001-002 will only render frame 001)

-Ambie-Ambient Occlusion and Shadow passes require a plane or other geometry to be 
visible in the scene at me of render.  It is beer to use a basic stac mesh plane than 
the default floor plane.  Also, you will need to change the Light Map Res se ng of the 
geometry that will be receiving shadows (floor plane).  The Default is 128 and will give 
poor results.  I was able to get good results with 2048 se ng.  This is found in the 
details panel of the object receiving shadow under the lighng tab.  Check Overridden 
Light Map Res.  I also had beer results when se ng the ground plane lightmap type 
to to Force Surface.  Aer 
changing the se ngs and
 finalizing light posions 
(I had best results with 
staonary lights), you 
will need to Build Lighng
This can take a while but 
is essenal to get quality
 shadows.
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Exporng Render Passes from UE cont.

Beauty, Alpha, and Lighng Only

This pThis process ulizes the Cinemacs Movie Render Queue to render a mulchannel .exr  
with beauty layer (RGBA) , and Lighng Only layer (RGBA). Only the Cinemacs Movie 
Render Queue can generate alpha passes and you can get two different versions of the 
alpha (hard and soened) from this method. The alpha will be based on any geometry 
visible in the sequence, so hide floor plane and any other geo if you do not want it 
included in the alpha. The Lighng Only pass can be very useful in comp and can get 
you close to the Specular pass from Arnold.

The PThe Process:
-Enable Movie Render Queue and Movie Render
Queue Addional Rednder Passes Plugins 
Found under Edit > Plugins (restart required)
- Window > Cinemacs > Movie Render Queue
-Choose sequence to render
-click on unsaved configuraon under se ngs

-Click i-Click into green +se ngs box drop down 
menu. Select .exr sequence, deferred render, 
and deferred render(Lighng Only).  Delete 
other image sequence outputs (jpg, bmp etc.)

-.exr sequence se ngs: compression (PIZ is 
default and works well).  Check mullayer.
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Beauty, Alpha, and Lighng Only cont.

-deferred render se ngs:  Check Accumulator includes Alpha.  Check Disable post 
process (disables moon blur on rgba beauty pass. Only Cinemac Movie Render 
Queue adds moon blur by default)

-d-deferred render(Lighng Only)se ngs:  Check Accumulator includes Alpha.  Uncheck 
Disable post process (enables moon blur).  This will give you an alpha channel on the 
Lighng Only layer that has moon blur, creang soer edges.  This provides a second 
opon for the alpha that can be used in comp.

-Choose file resoluon and write locaon in se ngs (below deferred render) >  output 
*note – by default your file will be named aer the level, and frame number.  It will not 
be name “beauty” unless you change the naming format.*
-Accept
-Render Local

click to set render 
resoluon
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Base Color, Post ToneMapColor, Normal, Depth

This process ulizes the Sequencer to render mulple single rgba layer .exr sequences 
to be used in comp.  *note -The shadows will be dealt with separately, so any floor 
planes or other geo that you don’t need rendered should be hidden by unchecking 
Visibility and checking Actor Hidden in Game in the detail panel of selected actor 
(mesh object).*

-Select -Select render icon above track 
lisngs in sequencer and set 
Render Movie Se ngs as follow:

Image Output Format:
 Custom Render Passes

Included Render Passes: 
Base Color
SScene Depth
World Normal
Post Tonemap HDR Color

Check Capture Frames in HDR
(this changes output to .exr files)

HDRCompression Quality: 
Default is 1 and gives great result

CaCapture Gamut:  
Rec. 709 / sRGB  is standard and 
will work, but to avoid having to 
change colorspace in Nuke, 
select Linear.

Check Use Separate Process 
(will not render correct resoluon 
without this checwithout this checked)

-Click Capture Movie *note – this will open a fullscreen render window that may 
appear black if your output resoluon is larger than your viewer screen and your 
objects are not in the visible part of the frame. The render process will take a few 
minutes depending on your project and se ngs.*
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Ambient Occlusion:

Before rendering AO pass, make sure ground plane is visible and not hidden in game.  
Refer to note on page 10 regarding Override Light Map Res. 

The process is exactly the same as 
the previous render passes (color 
etc..) using the Sequencer’s 
RRender Movie Se ngs, but with
 only Ambient Occlusion Render 
pass selected.  

The values of the AO pass are very low so you will need to adjust black point and white 
point in Nuke to be able to use.

Shadow:

The beThe best method I have found for creang a cast shadow layer is to render a Final 
Image render pass though the Sequencer with the object hidden, but the shadows 
shown.  Ulizing a simple roto and grade in Nuke, you can get a mae to use for 
shadows.

TTo achieve this, go to the Details panel of the object you want to cast a shadow, uncheck 
Visible, check Actor Hidden In Game, make sure Cast Shadows is checked, and check 
Hidden Shadow.  This only works with cast shadows as contact shadows will not be 
rendered when object is hidden. 
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Contact Shadow:
Rendering contact Shadows from UE are a challenge. For Contact Shadows, I also use a 
Final Image render pass similarly to the cast shadow, but with the object Visible, and 
Cast Shadows turned off.  

Make the object visible (check Visible, uncheck Hidden In Game).  Uncheck Cast Shadow. 

The correct control for the contact shadow is on the light(s).  

In the DIn the Details panel of the light, change Contact Shadow length to get close to the 
results you want.  The quality is limited but gives you something to work with in Nuke.  
You will have to mask out the main object and use roto to achieve desired effect, but at 
least you have something to work with. 

Created by Kyle Ragsdale 
 The Los Angeles Film School - 2021

kyleragsdalevfx.com
kyleragsdalevfx@gmail.com

Addional Resources:

hps://docs.unrealengine.com/en-US/WorkingWithContent/Imporng/Alembi
cImporter/index.html

 
hps://docs.unrealengine.com/en-US/AnimangObjects/Sequencer/HowTo/G

eometryCacheTrack/index.html

hhps://docs.unrealengine.com/en-US/RenderingAndGraphics/Materials/HowT
o/Instancing/index.html

Export Alembic Animaons to Unreal Engine the correct way 
hps://youtu.be/b_FvqQyyYFk

How to IMPORT an FBX Camera to Unreal (Maya) 
hps://youtu.be/qtxLmWquOOY
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https://docs.unrealengine.com/en-US/RenderingAndGraphics/Materials/HowTo/Instancing/index.html
https://docs.unrealengine.com/en-US/AnimatingObjects/Sequencer/HowTo/GeometryCacheTrack/index.html
https://docs.unrealengine.com/en-US/WorkingWithContent/Importing/AlembicImporter/index.html



